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ВСТУП 
 

Лабораторний практикум є навчально-методичною базою для виконання 

лабораторних робіт з курсу "Теорія автоматичного управління" (ТАУ) студентами 

спеціальностей 7.05020201 "Автоматизоване управління технологічними 

процесами" та 7.05020202 "Комп’ютерно-інтегровані технологічні процеси і 

виробництва". 

Однією з найважливіших задач теорії автоматичного управління є вивчення 

динамічних процесів в автоматичних системах. Не дивлячись на велику 

різноманітність складових елементів автоматичних систем, які відрізняються між 

собою за фізичною природою, конструктивним виконанням, потужністю, видом 

енергії живлення тощо, можна виділити тільки декілька типових динамічних 

ланок. 

Динамічною ланкою, або просто ланкою, називається елемент (частина) 

автоматичної системи, який має визначені динамічні властивості. Типовими 

ланками доцільно вважати такі, котрі можуть слугувати для побудови будь-яких 

інших ланок, що зустрічаються на практиці. 

Типові ланки є ланками направленої дії: сигнали передаються ланкою в 

одному напрямі – зі входу на вихід. При зміні вхідного сигналу змінюється і 

вихідний, якщо вхідний сигнал не змінюється, не повинен змінюватися і вихідний 

сигнал. Для того, щоб елемент САК зображувався направленою ланкою, необхідно 

враховувати навантаження на її виході. При з’єднанні ланок напрямленої дії вони 

зберігають свої попередні властивості. 

Елемент автоматичної системи не обов’язково зображувати однією типовою 

ланкою. В залежності від складності рівняння елементу він може бути 

представлений декількома типовими ланками, з’єднаних між собою. Більш того, 

ланки не обов’язково представляти конкретним елементом САК. Вони можуть 

відповідати деякій математичній залежності. 

Мета практикуму: розвиток та закріплення у студентів навиків практичного 

структурного аналізу та проектування систем автоматичного керування, вивчення 

динамічних властивостей та побудова динамічних характеристик різних ланок 

автоматичних систем у часовому та частотному просторі. 

Виконання лабораторних робіт передбачає використання потужної системи 

комп’ютерної алгебри MathCAD та засобу візуальної мови програмування для 

моделювання динамічних систем VisSim. Кожна робота містить опис команд 

MathCAD та VisSim, які можуть бути використані при виконанні завдань. 

Підготовку до лабораторних робіт рекомендується виконувати в такій 

послідовності: 

1) вивчити літературу по даній темі; рекомендовані посібники [1-4]; 

2) виконати попереднє розрахункове завдання, використовуючи методичні 

вказівки. Для поглибленого знайомства з можливостями MathCAD та 

VisSim, можуть бути рекомендовані посібники [5,6]; 

3) вивчити робоче завдання і методичні вказівки до його виконання. 

Попереднє розрахункове завдання виконується заздалегідь і включається в 

звіт по лабораторній роботі. Графіки і характеристики роздруковуються на 

принтері. Кожний студент виконує звіт індивідуально і представляє його 

викладачу при захисті відповідної лабораторної роботи. 
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Лабораторна робота №1 

 

ДОСЛIДЖЕННЯ ЧАСОВИХ ХАРАКТЕРИСТИК ЛІНІЙНИХ СИСТЕМ 

 

Мета роботи: експериментально дослiдити перехідні характеристики 

лінійних систем, вимiряти амплiтуднi i часовi параметри вхiдної i вихiдної дії, 

порiвняти експериментально одержані часові характеристики з теоретично 

одержаними часовими характеристиками. 

 

1. Основнi теоретичнi вiдомостi. 

Часовою характеристикою ланки називається графік зміни  вихiдної 

величини y(t) по визначеному закону i при умовi, що до прикладення  

зовнiшньої дiї ланка була в станi спокою.  Часові характеристики залежать вiд 

властивостей системи i вiд характеру зовнішньої дiї, для  якої  вони 

визначаються. Можна розглядати цi характеристики по вхiднiй дії x і по 

збуренню f . При визначеннi часових  характеристик по якiй-небудь зовнiшнiй 

дiї інші дії дорiвнюють нулю. 

В данiй лабораторнiй роботi розглядають часовi характеристики тiльки по 

вхiднiй  величинi x,  яка змiнюється  по закону одиничної сходинкової дії, або 

по закону дельта-функції. 

Часовi характеристики  ланки  при цих законах змiни зовнiшнiх дiй 

називаються відповідно перехідними характеристиками і імпульсними 

перехідними  характеристиками системи або ланки.  

Перехiдною характеристикою називається графік зміни в часі  вихідної 

величини  ланки або системи, коли  на вхід подається одинична сходинкова дія. 

Одинична сходинкова дія – це дія, яка миттєво змінюється від нуля до одиниці і 

надалі залишається незмінною. 

На рис.1 показані  перехідні характеристики різних систем. 

Аналітичним виразом для перехідної характеристики є перехідна 

функція, яка позначається h(t). Аналітичним виразом одиничної сходинкової дії 

є одинична сходинкова функція, яка позначається 1(t) і може бути описана 

таким виразом: 










01

00
)(1

tпри

tпри
t  

Таким чином, h(t) – це вираз для у(t) при х(t)=1(t). 

Поряд з перехідною характеристикою використовується імпульсна 

перехідна характеристика, яка є реакцією системи або ланки на одиничний 

імпульс. Одиничний імпульс – це математична ідеалізація гранично короткого 

імпульсного сигналу. Одиничний імпульс – це імпульс, площа якого дорівнює 

одиниці при тривалості, що дорівнює нулю і висоті, рівній нескінченності. 
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На рис.2 цей імпульс умовно показаний в вигляді потовщення на осі 

ординат. На цьому ж малюнку зображені різні типові форми імпульсних 

перехідних характеристик. 

 
Аналітичним виразом для імпульсної перехідної характеристики є 

імпульсна перехідна функція або вагова функція (функція ваги), яка 

позначається ω(t). Вираз для одиничного імпульсу називається одиничною 

імпульсною функцією або дельта-функцією і позначається δ(t). Таким чином, 

ω(t) – це у(t) при x(t)=δ(t). 

Математично дельта-функцію можна записати так: 










00

0
)(

tпри

tпри
t  

 

При цьому згідно визначення 






 1)( dtt  

у(t) 

х=δ(t) 

W(p) 

х=δ(t) y(t)=ω(t) 

Рисунок 2 

t 

W(p) 

x(t)=1(t) 

t 

y(t)=h(t) x(t)=1(t) 

y(t) 

Рисунок 1 
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Дельта-функція просто зв’язана з одиничною сходинковою дією: 

δ(t)=1'(t) 

Аналітичний зв’язок між перехідною і ваговою функціями лінійних ланок 

можна записати у вигляді 

ω(t)=h'(t), 


t

tdtth
0

).()()(   

Перехідну функцію можна визначити експериментально або обчислити 

теоретично, використовуючи передавальну функцію W(s). 

Якщо система в загальному описана лінійним диференціальним 

рівнянням 

(a0p
n
+a1p

n-1
+ …+an)y=(b0p

m
+b1p

m-1
+…+bm)x    (1) 

або 

Q(p)y=R(p)x, 

де 
dt

d
p   – символ диференціювання по часу, то передавальною функцією в 

операторній формі називається відношення оператора дії R(p) до власного 

оператора Q(p) і позначається  

W(p)=
)(Q

)(

p

pR
. 

В зображеннях Лапласа рівняння (1) має вигляд 

 

Q(s)Y(s)=R(s)X(s). 

 

Передавальною функцією в формі зображення Лапласа  називається 

відношення зображення вихідної величини до зображення вихідної величини 

при нульових початкових умовах. 

)(Q

)(

)(

)(
)(

s

sR

sX

sY
sW   

Якщо досліджувана система (ланка) описується передавальною функцією 

W(s), то враховуючи, що зображення одиничної сходинкової функції 

  
S

tL
1

1  , зображення перехідної функції має вигляд 

.
)(

)(
s

sW
sH   

Звідки 









 

s

sW
Lth

)(
)( 1  

Тобто, перехідна функція є зворотнім зображенням передавальної функції 

поділеної на s. 

Оригінал перехідної функції можна визначити, як суму лишок в 

особливих точках. 

Для випадку, коли всі корені характеристичного рівняння Q(s)=0 різні 



 7 

 
 

 




n

i

ts

i

i ie
s

sR
th

1
'Q

, 

коли знаменник функції H(s) має один нульовий корінь 







n

ti

ts

ii

i ie
ss

sRR
th

)(Q

)(

)0(Q

)0(
)(  

в загальному випадку 

 stn
in

nl

i i

esssH
ds

d

n
th i

i

i

))((
)!1(

1
)(

1

1

ss1
lim

i












, 

де: R(s) поліном чисельника H(s); Q
’
(s) – похідна від полінома знаменника H(s); 

si – полюси функції H(s), тобто корені характеристичного рівняння Q(s)=0; l- 

кількість різних коренів; ni – кількість однакових коренів. 

Результати обчислень перехiдної функцiї представляють у виглядi 

графiка, побудованого  в  координатах  (h, t).  Конкретнi  графiки функцiї h(t) 

(монотоннi,  коливнi, аперіодичні) залежать  вiд  властивостей системи (ланки) i 

можуть бути самими рiзними. 

Початкові (при t0+) i кiнцевi (при t) значення перехiдної функцiї 

можна  визначити без обчислення самої функцiї h(t). 

За теоремою про початкове значення 

   sW
ss

ssHh



 lim0 )(  

За теоремою про кiнцеве значення 

   ssHh
s
lim

0

  

Для лiнiйних систем (ланок) при неодиничному стрибку  вхiдної  

величини x(t)=A·1(t) вихiдна  величина буде змiнюватися на закон y(t)=A·h(t) , 

де А=const. 

Функцiю ваги можна визначити теоретично або експериментально. Для 

експериментального визначення ω(t) оцилографується процес змiни вихiдної 

величини при вхiднiй дiї в виглядi реального iмпульса довiльної форми, площа 

якого дорівнює одиниці. 

Методична похибка буде тим менша, чим менша тривалiсть вхiдного 

iмпульса в порiвняннi з часом перехiдного процесу в дослiджувальнiй ланцi. 

Для ланки з передавальною функцiю W(p) з врахуванням того, що 

  1)( tL  , зображення функції ваги має вигляд      sWtL  . 

Звідки видно, що функція ваги є зворотнiм перетворенням Лапласа вiд 

передавальної функцiї ланки         sWLt 1 . 

Функцiю ваги обчислюють так само,  як i оригiнал  перехiдної функцiї. 

Початкове i кiнцеве значення функцiї ваги можуть бути  визначенi по 

формулах: 

   ssW
s
lim0



 , 
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   sW
s
lim

0

  

Якщо на вхiд лiнiйної ланки подається неодинична дельта-функцiя 

x(t)=A(t), де А=const, реакцiя ланки на цей сигнал дорiвнюѕ y(t)=A·ω(t). 

Графiк функцiї ваги будується в координатах (ω,t).  Характер графiка ω(t) 

залежить вiд властивостей ланки. 

Зв’язок мiж перехiдною функцiєю i функцiєю ваги можна визначити на 

основі теореми про зображення похідної 

          00 
 hsWhssHthL  

звідки 

       0hthLsW . 

Перехiд від зображення до оригiналiв дає таку залежнiсть: 

 
     tSh

dt

tdh
s 

0  

 

2. Попереднi завдання для обчислень. 

1. Записати передавальну функцiю системи, яка описується 

диференціальним рівнянням 
2

0 1 2 0 12

d y dy dx
a a a y b b x

dt dt dt
     

де 2

0 1 2, 2 , 1a T a T a   , 0 , .b k T  

Числові значення параметрів задані в таблиці 1. 

2. Записати вираз для перехідної функції системи згідно заданого 

варіанту (Таблиця 1) 

3.Записати вираз для імпульсної перехідної функції вказаної системи. 
 

Таблиця 1 

Варіант Т·10
-4 

 
1
/с ξ k b1 

1 9,4 0,263 2,8 0 

2 9,3 0,271 2,9 0,001 

3 9,2 0,280 2,95 0,002 

4 9,1 0,290 3,0 0,003 

5 9,0 0,295 3,1 0,004 

6 8,9 0,3 3,2 0,005 

7 8,8 0,31 3,3 0,006 

8 8,7 0,32 3,4 0,007 

9 8,6 0,33 3,5 0,008 

10 9,5 0,26 2,83 0 

11 9,6 0,25 2,89 0,001 

12 9,7 0,24 2,93 0,002 

13 9,8 0,23 3,00 0,003 

14 9,9 0,22 3,1 0,002 

15 10 0,23 2,8 0,003 

16 10,1 0,25 2,7 0,002 

17 10,2 0,26 2,9 0,001 
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18 9,3 0,27 3,0 0,002 

19 9,2 0,3 3,2 0,001 

20 9,1 0,33 3,3 0,002 

21 9,0 0,34 3,0 0 

22 9,6 0,28 3,1 0,001 

23 9,7 0,31 3,4 0,002 

24 9,8 0,30 2,9 0,003 

25 10 0,25 3,0 0,006 

 

2.1 Приклад виконання попередніх завдань для обчислень 
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2
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;
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    

     
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3. Робоче завдання 

 

1. Отримати осцилограму перехідної функції досліджуваної системи. 

2. Отримати осцилограму імпульсної перехідної функції досліджуваної 

системи. 

4. Виконання робочого завдання 

 

1. Для побудови перехідної характеристики системи заданої 

передавальною функцією, засобами VisSim створюється наступна схема: 

 
Рисунок 3 – Побудова перехідної характеристики 

 

Для цього спочатку з меню "Blocks -> Signal Producer" вибирається блок 

"step".  

Потім з меню "Blocks -> Linear System" блок "transferFunction". Після 

того, як блок розташований на листі діаграми, клацанням правої кнопки миші 

викликається вікно налаштувань цього блоку (див. рис. 4) і встановлюються 

відповідні значення. 

 
Рисунок 4 – Властивості передавальної функції 

 

Останній блок – блок  графіків "plot" з меню "Blocks -> Signal Consumer". 
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Розташовані блоки з'єднуються лініями функціональних зв'язків. 

У налаштуваннях моделювання "Simulate -> Simulation Properties". 

встановлюється час початку, кінця моделювання і крок (рис. 5). 

 

 
Рисунок 5 – Налаштування моделювання 

 

Модель запускається на виконання (командою "Simulation -> Go" або 

натисненням клавіші F5 клавіатури або натисненням кнопки Go панелі 

інструментів). Результат представлений на рис. 1. 

Для роздруку перехідних кривих на принтері слід збільшити вікно графіків 

"plot" в увесь екран і дати команду "File -> Print". чи натиснути на кнопку 

"Print" панелі інструментів.  

В звіт необхідно подати збільшене в увесь екран та коректно 

змасштабоване вікно графіків "plot". 
2. Для побудови імпульсної перехідної характеристики системи, необхідно 

на вхід системи подати дельта-функцію. Для цього копіюємо схему з файлу 

“Delta.vsm” і з’єднуємо її вихід з входом досліджуваної системи (див. рис. 6). 

 

 
Рисунок 6 – Побудова імпульсної перехідної характеристики 

 

3. Порівняти результати, отримані в результаті моделювання з теоретично 

одержаними часовими характеристиками. 

4. Пояснити одержані результати (висновки).  
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5. Порядок оформлення звіту 

 

Звіт оформляється відповідно до вимог ЄСКД на білому папері формату 

А4. На титульному аркуші вказуються назви міністерства, вузу, кафедри, 

роботи, прізвище студента, прізвище викладача. 

Звіт повинен містити наступні матеріали: 

1) тему і мету роботи; 

2) початкові дані; 

3) виконане попереднє завдання для обчислень; 

4) схему змодельованої САК; 

5) отримані в результаті моделювання перехідні криві; 

6) висновки. 

 

6. Контрольні питання і завдання 

1. Дайте визначення перехідної характеристики і перехідної функції. 

2. Дайте визначення імпульсної перехідної характеристики і функції 

(функції ваги). 

3. Назвіть типові форми перехідної характеристики. 

4. Дайте визначення передавальної функції в операторній формі і 

формі перетворення Лапласа. 

5. Дайте визначення одиничної дії і одиничного імпульсу і їх 

аналітичних виразів. 

6. Запишіть в загальному вигляді формулу теорем розкладу в випадку 

коли всі корені різні і коли один з коренів дорівнює нулю. 
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Лабораторна робота №2 
 

ДОСЛІДЖЕННЯ ЧАСТОТНИХ ХАРАКТЕРИСТИК ЛІНІЙНИХ 

СИСТЕМ 

 

Мета роботи: дослідити частотні характеристики лінійних систем і 

порівняти результати експериментальних досліджень з результатами 

теоретичних досліджень. 

 

1. Основнi теоретичнi вiдомостi 

Частотні характеристики описують усталені вимушені коливання на 

виході ланки чи системи, які  викликані гармонічною дією на вході. 

Нехай на вхід системи подається гармонічна дія 

,sin tXx m   

де Хm – амплітуда, а ω – кутова частота цієї дії. 

Після закінчення перехідного процесу на виході ланки є гармонічні 

коливання з частотою вхідних коливань, але відрізняються в загальному 

випадку амплітудою і фазою, тобто в усталеному режимі вихідна величина 

ланки  

y=Ymsin(ωt+φ), 

де Ym – амплітуда вихідних усталених коливань, а φ – фазовий зсув між 

вхідними і вихідними коливаннями. 

При фіксованій амплітуді вхідних коливань амплітуда і фаза усталених 

коливань на виході ланки залежать від частоти коливань. Якщо постійно 

збільшувати від нуля частоту коливань і визначати усталені значення амплітуди 

і фази вихідних коливань для різних частот, то можна одержати залежність від 

частоти відношення амплітуд A=Ym/Xm і зсуву фаз φ вихідних і вхідних 

усталених коливань. Ці залежності називаються відповідно А(ω) – амплітудною 

частотною характеристикою (AЧX, рис.1,а) і φ(ω) – фазовою частотною 

характеристикою (ФЧX, рис.1,б) 

. 

 

Аналітичні вирази А(ω) і φ(ω) називаються відповідно амплітудною і 

фазовою частотними функціями. 

А 

0  

0  

 

а) б) 

Рисунок 1. 
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Амплітудну і фазову частотні характеристики можна об”єднати в одну 

характеристику амплітудно-фазову частотну характеристику (АФЧХ), 

використовуючи А(ω) і φ(ω) в якості полярних координат (рис.2). 

 
Кожна точка амплітудно-фазової частотної характеристики відповідає 

певному значенню частоти ω. По АФЧХ можна побудувати амплітудну і фазові 

частотні характеристики.  

Амплітудно-фазову частотну характеристику можна побудувати і в 

прямокутній системі координат – в комплексній площині. При цьому 

координатами будуть показані на рис.2, проекції U і V вектора А на відповідні 

осі. Залежності U(ω) і V(ω) називаються відповідно дійсною і уявною 

частотними характеристиками. 

Аналітичні вирази для розглянутих частотних характеристик можна 

одержати з передавальних функцій. Якщо в вираз перевальної функції W(p) 

підставити p=jω, то одержують комплексну функцію W(jω), яка є функцією ω і 

називається амплітудно-фазовою частотною функцією.  

Ця функція є аналітичним виразом для амплітудно-фазової частотної 

характеристики. Відповідно її модуль є аналітичним виразом для амплітудної 

частотної характеристики, тобто амплітудною частотною функцією А(ω), а 

аргумент – виразом для фазової частотної характеристики, тобто фазовою 

частотною функцією φ(ω). Зв’язок між частотною передавальною функцією і 

частотними функціями можна записати у вигляді 

W(јω)=А(ω)е
јφ(ω)

, 

або в алгебраїчній формі 

W(јω)= U(ω)+ј V(ω), 

де дійсна і уявна частини V(ω) і U(ω) є координатами амплітудно-фазової 

характеристики в комплексній площині. 

Зв’язок між частотними функціями записується такими 

співвідношеннями 

)()()( 22  VUA  , 

)(

)(
)(






U

V
arctg , 

   

 =  

0 = 0 Ui 

jVi 

i 

Ai 

Рисунок 2. 

1  

2  

і  

jV() 

U() 
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),(cos)()(  AU   

)(sin)()(  AV  . 

Частотні функції А(ω), φ(ω), U(ω) i V(ω)  просто визначаються з 

перевальної функції W(p), після підстановки p=jω: 

),()()(
)()(

)()(

)(

)(
)( )( 








  jVUeA

jVU

jVU

jQ

jR
jW j

QQ

RR 



  

де 

,

)()(

)()(
)(

22

22






QQ

RR

VU

VU
A




  

( )( )

( ) ( )

QR

R Q

VV
arctq arctq

U U




 
   

і 

)()(

)()()()(
)(

22 




QQ

QRQR

VU

VVUU
U




 , 

)()(

)()()()(
)(

22 




QQ

QRQR

VU

VUUV
V




 . 

При дослідженні систем автоматичного керування  амплітудну і фазову 

частотні характеристики зручно будувати в логарифмічних координатах. 

Функцію 

)(20)(20)(  jWlqlqAL   

називають логарифмічною амплітудною частотною функцією. Графік 

залежності логарифмічної амплітудної частотної функції )(L  від частоти ω 

або логарифму частоти lg(ω) називають логарифмічною амплітудною 

частотною характеристикою (ЛАЧХ). При побудові ЛАЧХ по осі абсцис 

відкладають частоту в логарифмічному масштабі, а по осі ординат - )(L . 

Логарифмічною фазовою частотною характеристикою (ЛФЧХ) називають 

графік залежності фазової частотної функції φ(ω) від логарифму частоти lqω. 

Одиницею )(L  є децибел, а одиницею логарифму частоти в ЛЧХ – 

декада. Декадою називають інтервал, на якому частота змінюється в 10 раз. 

Вісь ординат при побудові ЛЧХ проводять через довільну точку, а не 

через точку ω=0. Частоти ω=0 відповідає нескінченно віддалена точка: lqω→∞ 

при ω→0. 

 

2. Попереднє завдання 

 

1. Записати передавальні функції системи, яка описується 

диференціальним рівнянням 

xb
dt

dx
bya

dt

dy
a

dt

yd
a 10212

2

0   

де 2

0 1 2, 2 , 1a T a T a   , 0 .b k T  

Числові значення параметрів задані в таблиці 1. 
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2. Записати формули для розрахунку частотної характеристики 

досліджуваної системи {А(ω), φ(ω), U(ω), V(ω)}. 

3. Побудувати годографи а.ф.х. досліджуваної системи згідно 

вказаного варіанту (Таблиця 1) 

4. Побудувати асимптотичні л.а.х. досліджуваної системи. 

5. Визначити спряжену частоту ωс і частоту зрізу ωзр по л.а.х. 

досліджуваної системи. 

 

Таблиця 1 

 Т·10
-4 

 
1
/с ξ k b1 

1 9,4 0,263 2,8 0 

2 9,3 0,271 2,9 0,001 

3 9,2 0,280 2,95 0,002 

4 9,1 0,290 3,0 0,003 

5 9,0 0,295 3,1 0,004 

6 8,9 0,3 3,2 0,005 

7 8,8 0,31 3,3 0,006 

8 8,7 0,32 3,4 0,007 

9 8,6 0,33 3,5 0,008 

10 9,5 0,26 2,83 0 

11 9,6 0,25 2,89 0,001 

12 9,7 0,24 2,93 0,002 

13 9,8 0,23 3,00 0,003 

14 9,9 0,22 3,1 0,002 

15 10 0,23 2,8 0,003 

16 10,1 0,25 2,7 0,002 

17 10,2 0,26 2,9 0,001 

18 9,3 0,27 3,0 0,002 

19 9,2 0,3 3,2 0,001 

20 9,1 0,33 3,3 0,002 

21 9,0 0,34 3,0 0 

22 9,6 0,28 3,1 0,001 

23 9,7 0,31 3,4 0,002 

24 9,8 0,30 2,9 0,003 

25 10 0,25 3,0 0,006 
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2.1 Приклад побудованих характеристик 
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3. Робоче завдання 

 

1. Зняти залежності А=ƒ(ω) і φ=ƒ(ω) досліджуваної системи. 

2. Побудувати годографи АФЧХ досліджуваної системи. 

3. Побудувати ЛАХ досліджуваної системи. 

4. Визначити спряжену частоту ωс і частоту ωзр досліджуваної системи. 

5. Побудувати ЛФХ досліджуваної системи. 

6. Порівняти результати теоретичних і експериментальних досліджень. 

 



 20 

4. Виконання робочого завдання 

 

1. Досліджувана схема аналогічна до тієї, що використовувалась в л. р. №1 

і місить джерело сигналу, передавальну функцію та блок графіків "plot". 

 
Рисунок 3 

 

2. Для побудови годографа а.ф.х. (годографа Найквіста) необхідно 

спочатку виділити блок передавальної функції досліджуваної системи і 

виконати команду: "Analyze -> Nyquist Response".  
 

3. Перед побудовою частотних характеристик, потрібно задати початкове, 

кінцеве значення частоти та крок приросту за допомогою команди "Analyze -> 

Frequency Range" (рис. 4). 

 
Рисунок 4 – Налаштування частотного аналізу 

 

4. Для побудови логарифмічних амплітудної та фазової частотних 

характеристик необхідно спочатку виділити блок передавальної функції 

досліджуваної системи і виконати команду: "Analyze -> Frequency Response". 
Отримані частотні характеристики зображені на рис. 3: 

 
Рисунок 5 – Частотні характеристики  
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5. Порівняти результати, отримані в результаті моделювання з теоретично 

одержаними часовими характеристиками. 

6. Пояснити одержані результати (висновки).  

 

5. Порядок оформлення звіту 

 

Звіт оформляється відповідно до вимог ЄСКД на білому папері формату 

А4. На титульному аркуші вказуються назви міністерства, вузу, кафедри, 

роботи, прізвище студента, прізвище викладача. 

Звіт повинен містити наступні матеріали: 

1) тему і мету роботи; 

2) початкові дані; 

3) виконане попереднє завдання для обчислень; 

4) схему змодельованої САК; 

5) отримані в результаті моделювання частотні характеристики; 

6) висновки. 

 

6. Контрольні питання і завдання 

 

1. Перелічіть основні частотні характеристики. 

2. Дайте визначення амплітудної і фазової частотної характеристик. 

3. Викладуть методику побудови амплітудно-фазової частотної 

характеристики. 

4. Запишіть вираз амплітудно-фазової частотної функції. 

5. Як одержати логарифмічні частотні характеристики і які їх 

переваги ? 
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Лабораторна робота №3 

 

ДОСЛIДЖЕННЯ ЧАСОВИХ І ЧАСТОТНИХ ХАРАКТЕРИСТИК 

АПЕРІОДИЧНОЇ ЛАНКИ ПЕРШОГО ПОРЯДКУ 

 

Мета роботи: експериментально дослідити часові і частотні 

характеристики аперіодичної ланки першого порядку. 

 

1. Основні теоретичні відомості 

Аперіодичні ланки першого порядку описуються диференціальними 

рівняннями 

.kxy
dt

dy
T   

Передавальна функція ланки в операційній формі має вигляд 

,
1

)(
Tp

k
pW


  

в формі перетворення Лапласа 

( ) .
1

k
W s

Ts



 

Приклади аперіодичних ланок першого порядку: 

1) двигуни будь-якого типу (електричні, гідравлічні, пневматичні та 

ін.) механічні характеристики яких представлені паралельними прямими. 

Вхідною величиною х є керуюча дія в двигуні, витрата рідини в гідравлічному 

двигуні і т.п. Вихідною величиною у є швидкість обертів двигуна; 

2) електричний генератор постійного струму, вхідною величиною 

якого є напруга обмотки збудження Uзб, а вихідною напруга якоря; 

3) резервуар з газом, у якого вхідною величиною є тиск Р1 перед 

впускним отвором, а вихідною – тиск Р2 в резервуарі; 

4) нагрівна піч, у якій вхідною величиною є кількість тепла, що 

поступає в одиницю часу в піч, а вихідною – температура в печі; 

5) електричні RC-  і LR- кола. 

 

Часові функції і часові характеристики аперіодичної ланки першого 

порядку. 

Перехідна функція ланки має вигляд 

T

t

ekth


 1()( )      (1) 

Перехідна характеристика зображена на рис.1 
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Чим більше значення постійної часу Т, тим довше триває перехідний 

процес. Практично тривалість перехідного процесу tП=3T. Постійна часу 

характеризує інерційність аперіодичної ланки і є мірою інерційності цієї ланки. 

Імпульсна перехідна функція t (функція ваги) представляється у 

вигляді 

 
t

T
k

t e
T




      (2) 

Імпульсна перехідна характеристика ланки показана на рис.2 

 
 

Частотні характеристики аперіодичної ланки першого порядку. 

Амплітудно-фазова частотна функція (частотна передавальна функція) 

представлена в алгебраїчній формі має вигляд 

,
111

)(
2222 T

Tk
j

T

k

Tj

k
jW















      (3) 

де 
221 T

k


=U(ω) – дійсна частотна функція, 

221 T

Tk






  – уявна частотна 

функція. 

Відповідно цій функції амплітудно-фазова частотна характеристика 

(АФЧХ) зображена на рис.3 

ω(t) 

0 
T 

t 

k/T 

Рисунок 2. 

h(t) 

k 

0 t 

T 

Рисунок 1. 
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Амплітудно-фазова частотна функція записана в показниковій формі має 

вигляд  

Tjarctge
T

k
jW 




221
)(      (4) 

З (4) видно, що амплітудна частотна функція 

,

1

)(
22T

k
A






  

а фазова частотна функція 

Tarctg )( . 

Відповідні їм амплітудна частотна характеристика і фазова частотна 

характеристика представлені на рис.4. 

 
 

З амплітудної частотної характеристики видно, що при малих частотах 

( )
1

T
  відношення амплітуд близьке до коефіцієнта передачі k. Коливання для 

частот 
T

1
  ослаблюються. Чим менше Т тим менша інерційність ланки і тим 

ширша полоса пропускання П  ланки: 

.
211

TTT
П 








  

Логарифмічна частотна функція для даної ланки має вигляд 

  .1lg20lg20

1

lg20lg20)( 22

22
Tk

T

k
jWL 


 



  

 

-1/T  

k/√2 
 k 

П 

 

Рисунок 4. 

 

 

- 

1/T 

сп=

1/Т 

 

зр 

-20 
дБ

/дек 

 0 
дБ

/дек 

L( 

Рис. 

5. 
1/T 

- 

 

 

Рис. 

4. 
 

 

 k jV 



 

  
U 

0 

Рисунок 3. 
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На рис.4 показана асимптотична логарифмічна частотна характеристика 

(ЛАХ) (суцільна лінія) і точна ЛАХ (пунктирна лінія), де 
T

сп
1

  – спряжена 

частота, а ωзр - частота зрізу, при якій А()=1. 

 
 

2. Попередні завдання для обчислення 

1. Записати передавальну функцію  ланки, яка описується 

диференціальним рівнянням 

xbya
dt

dy
a 010  , 

де 0 1 0, 1, 1a T a b   . 

Числові значення параметрів задані в таблиці 1. 

2. Записати вираз для перехідної функції ланки h(t) . 

3. Записати вираз для імпульсної перехідної функції ω(t)  ланки. 

4. Записати формули для розрахунку амплітудно-фазової частотної 

функції W(jω), амплітудної частотної функції А(ω), фазової частотної функції 

φ(ω), дійсної U(ω) і уявної V(ω) частотних функцій. 

5. Побудувати годографи АФЧХ і АЧХ досліджуваної ланки згідно 

варіанту. 

6. Побудувати асимптотичні ЛАХ коливної ланки. 

7. Визначити спряжену частоту ωсп і частоту зрізу ωзр по ЛАХ ланки. 

 

Таблиця 1 

Варіант 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

Т·10
-4 

 
1
/с 9,4 9,3 9,2 9,1 9,0 8,9 8,8 8,7 8,6 9,5 9,6 9,7 9,8 9,9 10 

 

Варіант 16 17 18 19 20 21 22 23 24 25 

Т·10
-4 

 
1
/с 10,1 10,2 9,3 9,2 9,1 9,0 9,6 9,7 9,8 10 

 

Рисунок 5. 

L( 
 0 

дБ
/дек 

-20 
дБ

/дек 

зр 
 

сп=1/Т 
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2.1 Приклад виконання попередніх завдань для обчислень 

 
Наведено лише вигляд досліджуваних характеристик. Усі необхідні 

формули функцій для їх побудови приведені в теоретичних відомостях. 

 

Примітка. Маркери на відповідних осях (пунктирні горизонталі чи 

вертикалі на графіку) створюються наступним чином: 

 

- викликається вікно форматування графіка (подвійний клік ЛКМ в 

полі графіка) та ставиться галочка Show Markers (Показывать 
метки) по осі X та (чи)Y; 

 

 
 

- біля обраної осі (осей) з’являться 2 чорних прямокутники, в які 

можна ввести або числа, або ім’я константи. Ім’я писати зручніше, 

тому що при зміні значення константи, автоматично пересувається і 

маркер. 
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Примітка. Для коректного розрахунку АФЧХ, необхідно задати частоту у 

форматі дискретної змінної – : 0..100000  .  

Для отримання симетричної АЧХ – : 100000..100000   . 
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Примітка. Логарифмічну амплітудну характеристику можна побудувати 

(на вибір) або змінивши масштаб АЧХ на логарифмічний (рисунок зліва), або за 

відповідною формулою (рисунок справа). 
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3. Робоче завдання 

 

І. Дослідження часових характеристик ланки. 

1. Зняти осцилограму перехідної функції ланки. 

2. Зняти осцилограми імпульсної перехідної функції ланки. 

3. Порівняти результати експериментальних і теоретичних 

досліджень. 

 

ІІ. Дослідження частотних характеристик 

1. Зняти залежності А=ƒ(ω) і φ=ƒ(ω) досліджуваної ланки. 

2. Побудувати годографи АФЧХ досліджуваної ланки. 

3. Побудувати ЛАХ досліджуваної ланки. 

4. Визначити спряжену частоту ωс і частоту ωзр досліджуваної ланки. 

5. Порівняти результати теоретичних і експериментальних 

досліджень. 

 

4. Виконання робочого завдання 

 

1. Скласти схему для дослідження перехідної характеристики. Отримати 

перехідні характеристики для значень сталої часу: 1) значення сталої часу 

розрахованого в попередньому завданні для обчислень Т0; 2) T > Т0; 3) T < Т0. 

Зробити висновок про вплив сталої часу на тривалість перехідного процесу. 

 

 
Рисунок 6 – Побудова перехідних характеристик 

 

2. Аналогічно скласти схему для дослідження імпульсної перехідної 

характеристики. Отримати характеристики для 1) T = Т0; 2) T > Т0; 3) T < Т0. 

 

 
Рисунок 7 – Побудова імпульсної перехідної характеристики 
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Для більшої наочності розгорнути блок графіків на весь екран та 

відобразити координатну сітку (Plot Properties, встановити прапорець  Grid 

Lines). 
 

       
 

Рисунок 8 – Властивості блоку графіків 

 

3. Побудувати годограф АФЧХ (годограф Найквіста). Для цього необхідно 

спочатку виділити блок передавальної функції досліджуваної системи і 

виконати команду: "Analyze -> Nyquist Response". 
 

4. Побудувати логарифмічні амплітудні та фазові частотні характеристики 

для різних значень сталої часу (виділити блок передавальної функції 

досліджуваної системи і виконати команду: "Analyze -> Frequency 
Response"). Відобразити на графіках координатну сітку, вказати значення 

сталої часу. Подати отримані графіки в звіт. Зробити висновок про вплив сталої 

часу на величину смуги пропускання та частоти зрізу. 

 

 
 

Рисунок 9 – Частотні характеристики 

 

5. Порівняти результати, отримані в результаті моделювання з теоретично 

одержаними часовими та частотними характеристиками. 
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6. Пояснити одержані результати (висновки). 

 

5. Порядок оформлення звіту 

Звіт оформляється відповідно до вимог ЄСКД на білому папері формату 

А4. На титульному аркуші вказуються назви міністерства, вузу, кафедри, 

роботи, прізвище студента, прізвище викладача. 

Звіт повинен містити наступні матеріали: 

1) тему і мету роботи; 

2) початкові дані; 

3) виконане попереднє завдання для обчислень; 

4) схему змодельованої САК; 

5) отримані в результаті моделювання часові та частотні характеристики; 

6) висновки. 

 

6. Контрольні питання і завдання 

1. Запишіть рівняння і передавальні функції аперіодичної ланки 

першого порядку. 

2. Перелічіть динамічні характеристики аперіодичної ланки першого 

порядку і запишіть їх рівняння. 

3. Перелічіть частотні характеристики аперіодичної ланки першого 

порядку і запишіть частотні функції. 

4. Наведіть приклади аперіодичних ланок першого порядку. 
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Лабораторна робота №4 

 

ДОСЛІДЖЕННЯ ЧАСОВИХ І ЧАСТОТНИХ ХАРАКТЕРИСТИК 

АПЕРІОДИЧНОЇ  ЛАНКИ ДРУГОГО ПОРЯДКУ 

 

Мета роботи: експериментально дослідити часові і частотні 

характеристики аперіодичної ланки другого порядку, порівняти 

експериментально одержані характеристики з теоретичними. 

 

1. Основні теоретичні відомості 

Аперіодична ланка другого порядку описується диференціальними 

рівняннями виду 

kxy
dt

dy
T

dt

yd
T  12

2
2

0 ,      (1) 

В операторній формі рівняння має вигляд 

(Т 2
0

р
2
+Т1р+1)у=kx,       (2) 

При цьому корені характеристичного рівняння Т 2
0

р
2
+Т1р+1=0 повинні 

бути дійсними, що виконується при умові Т1≥2Т0. 

Ліву частину рівняння можна представити в вигляді 

(Т2р+1)(Т3р+1)у=kx, 

де 2
0

2
11

3,2
42

T
TT

T  . 

Передавальна функція ланки в операторній формі має вигляд 

)1)(1(
)(

32 pTpT

k
pW


  

в формі перетворення Лапласа 

.
)1)(1()(

)(
)(

32 sTsT

k

sX

sY
sW


  

Аперіодична ланка еквівалентна двом аперіодичним ланкам першого 

порядку, які з’єднані послідовно одна з одною, з спільним коефіцієнтом 

передачі k і постійними часу Т3 і Т4. Аперіодичною ланкою другого порядку є 

також керовані двигуни постійного струму, в випадку коли 4ТЯ≤ТМ, де ТЯ – 

електромагнітна постійна часу кола якоря, ТМ – електромеханічна постійна часу 

двигуна. 

 

Часові функції і часові характеристики аперіодичної ланки другого 

порядку. 

Перехідна функція ланки має вигляд 

)1()( 32

32

3

32

2 T

t

T

t

e
TT

T
e

TT

T
kth







 . 

Перехідна характеристика зображена на рис.1 
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Імпульсна перехідна функція w(t) (функція ваги) записується у вигляді 

)()( 32

32

T

t

T

t

ee
TT

k
tw






  

Імпульсна перехідна характеристика показана на рис.2 

 
Частотні характеристики аперіодичної ланки другого порядку 

Амплітудно-фазова частотна функція (частотна передавальна функція) 

має вигляд 

)(

2
3

22
2

232

32

11)1)(1(
)(

TarctgTarctgj
e

TT

k

TjTj

k
jW




 






  (3) 

Амплітудно-фазова частотна характеристика аперіодичної ланки другого 

порядку зображена на рис.3 

ω(t) 

t 0 

Рисунок 2. 

h(t) 

t 

k 

0 

TH 

T3+T4 

4

3

43

43 ln
T

T

TT

TT


 

Рисунок 1. 
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З (3) видно, що амплітудна частотна функція  

,

11

)(
2

3
22

2

2

TT

k
A







  

а фазова частотна функція 32)( TarctgTarctg    

Відповідні їм амплітудна частотна характеристика і фазова частотна 

характеристика представлені на рис.4 

Логарифмічна частотна функція для даної ланки має вигляд  

2
3

22
2

2 11

lg20)(lg20)(

TT

k
jWL






     (4) 

Побудову асимптотичної логарифмічної частотної характеристики (ЛАХ) 

проводять, використовуючи вираз (4). Спочатку проводять допоміжні 

вертикальні лінії через спряжені частоти 
3

2
2

1
11

Т
i

T
СПСП   . Для 

визначеності побудови приймаємо, що Т2>Т3. 

 

Лівіше першої спряженої частоти (
2

1
1

T
СП  ) вираз (4) замінюють 

приближеним ,lg20)( kL   якому відповідає пряма з нульовим нахилом 

 k 

 jV 

ω=∞ ω=0 

 U 

 
32
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TT
  

Рисунок 3. 

 

 

 k 
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(перша асимптота ЛАХ). Для частот 
32

11

TT
  вираз (4) замінюють 

приближеним ,lg20)(
2T

k
L


   

якому відповідає пряма з від’ємним нахилом 20 дб/дек (друга асимптота). Для 

частот 
3

1

T
  вираз (4) замінюють приближеним 

 

,lg20)(

32
2 TT

k
L


   

якому відповідає пряма з від’ємним нахилом 40 дб/дек (третя асимптота) рис.5. 

Дійсна ЛАХ показана на рис.5 пунктиром. Вона відрізняється від 

асимптотичної в точках злому на 3 дб. 

 

2. Попередні завдання для обчислення 

1. Записати передавальну функцію аперіодичної ланки другого порядку, 

яка описується диференціальним рівнянням 

xbya
dt

dy
a

dt

yd
a 0212

2

0   

де 2

0 1 2 0, 2 , 1.5, 1,a T a T a b k        . 

Числові значення параметрів задані в таблиці 1. 

2. Записати вираз для перехідної  функції ланки h(t). 

3. Записати вираз для імпульсної перехідної функції ω(t) аперіодичної 

ланки другого порядку. 

4. Записати формули для розрахунку амплітудно-фазової частотної 

функції W(jω), амплітудної частотної функції А(ω), фазової частотної функції 

φ(ω), дійсної U(ω) і уявної V(ω) частотних функцій. 

5. Побудувати годографи АФЧХ і АЧХ досліджуваної ланки. 

6. Побудувати асимптотичні ЛАХ аперіодичної ланки другого порядку. 

L(ω) 

0 
дб

/дек 

-20 
дб

/дек 

ωзр 
ω 

 

lgω 

20lgk 

ωСП1=
2

1

T
 ωСП2=
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1

T
 

-40
 дб

/дек 

Рисунок 5 
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7. Визначити спряжену частоту ωсп і частоту зрізу ωзр по ЛАХ ланки. 

Таблиця 1 

Варіант Т·10
-4 

 
1
/с k 

1 9,4 2,8 

2 9,3 2,9 

3 9,2 2,95 

4 9,1 3,0 

5 9,0 3,1 

6 8,9 3,2 

7 8,8 3,3 

8 8,7 3,4 

9 8,6 3,5 

10 9,5 2,83 

11 9,6 2,89 

12 9,7 2,93 

13 9,8 3,00 

14 9,9 3,1 

15 10 2,8 

16 10,1 2,7 

17 10,2 2,9 

18 9,3 3,0 

19 9,2 3,2 

20 9,1 3,3 

21 9,0 3,0 

22 9,6 3,1 

23 9,7 3,4 

24 9,8 2,9 

25 10 3,0 

 

2.1 Приклад виконання попередніх завдань для обчислень 
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3. Робоче завдання. 

І. Дослідження часових характеристик ланки. 

1. Зняти осцилограму перехідної функції ланки. 

2. Зняти осцилограми імпульсної перехідної функції ланки. 

3. Порівняти результати експериментальних і теоретичних досліджень. 

 

ІІ. Дослідження частотних характеристик 

1. Зняти залежності А=ƒ(ω) і φ=ƒ(ω) досліджуваної ланки. 

2. Побудувати годографи АФЧХ досліджуваної ланки. 

3. Побудувати ЛАХ досліджуваної ланки. 

4. Визначити спряжену частоту ωс і частоту ωзр досліджуваної ланки. 

5. Порівняти результати теоретичних і експериментальних досліджень. 

 

4. Виконання робочого завдання 

 

1. Отримати перехідну характеристику аперіодичної ланки другого 

порядку засобами VisSim. 

 
Рисунок 6 – Побудова перехідної характеристики 

 

2. Отримати імпульсну перехідну характеристику аперіодичної ланки 

другого порядку засобами VisSim. 

 

 
Рисунок 7 – Побудова імпульсної перехідної характеристики 

 

3. Побудувати годограф АФЧХ (годограф Найквіста). Для цього 

необхідно спочатку виділити блок передавальної функції досліджуваної 

системи і виконати команду: "Analyze -> Nyquist Response". 
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4. Побудувати логарифмічні амплітудні та фазові частотні 

характеристики (виділити блок передавальної функції досліджуваної системи і 

виконати команду: "Analyze -> Frequency Response"). Відобразити на 

графіках координатну сітку. Подати отримані графіки в звіт. 

 

 
Рисунок 8 – Частотні характеристики 

 

5. Порівняти результати, отримані в результаті моделювання з теоретично 

одержаними часовими та частотними характеристиками. 

 

6. Пояснити одержані результати (висновки). 

 

5. Порядок оформлення звіту 

 

Звіт оформляється відповідно до вимог ЄСКД на білому папері формату 

А4. На титульному аркуші вказуються назви міністерства, вузу, кафедри, 

роботи, прізвище студента, прізвище викладача. 

Звіт повинен містити наступні матеріали: 

1) тему і мету роботи; 

2) початкові дані; 

3) виконане попереднє завдання для обчислень; 

4) схему змодельованої САК; 

5) отримані в результаті моделювання часові та частотні 

характеристики; 

6) висновки. 

 

6. Контрольні питання і завдання 

1. Запишіть рівняння і передавальні функції аперіодичної ланки другого 

порядку. 

2. Перелічіть динамічні характеристики аперіодичної ланки другого 

порядку і запишіть їх рівняння. 

3. Перелічіть частотні характеристики аперіодичної ланки другого 

порядку і запишіть частотні функції. 

4. Наведіть приклади аперіодичних ланок другого порядку. 
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Лабораторна робота №5 

 

ДОСЛIДЖЕННЯ ЧАСОВИХ І ЧАСТОТНИХ ХАРАКТЕРИСТИК 

КОЛИВНОЇ ЛАНКИ 

 

Мета роботи: експериментально дослідити часові і частотні 

характеристики коливної ланки, порівняти експериментально одержані 

характеристики з теоретично одержаними характеристиками коливної ланки. 

 

1. Основні теоретичні відомості. 

Коливна ланка описується такими ж диференціальними рівняннями, що і 

аперіодична ланка другого порядку 

kxy
dt

dy
T

dt

yd
T  12

2
2
2 ,      (1) 

але корені характеристичного рівняння 011

22

2  pTpT  повинні бути 

комплексними, що буде виконуватися при Т1<2Т2. 

Диференціальне рівняння в операторній формі звичайно представляють в 

вигляді 

(Т
2
р

2
+2ξТр+1)у=kx, 

або 

,1
2

2

2

kxyp
qq

p


















 

де q=
T

1
 – кутова частота вільних коливань (при відсутності затухання) а ξ – 

параметр затухання (коефіцієнт демпфування), який лежить в межах 0 < ξ < 1. 

Тоді корені характеристичного рівняння Т
2
р

2
+2ξТр+1=0 записуються в 

вигляді: 

2
2,1 1

1



 

T
j

T
jp  

Дійcна частина кореня 
T


   є коефіцієнтом затухання перехідного 

процесу, а уявна 21
1

 
T

 частотою затухаючих коливань. 

Передавальна функція коливної ланки в операторній формі має вигляд  

,
2

1
21

)(

2

222

q

p

q

k

pTTp

k
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
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а в формі перетворення Лапласа 
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Коливними ланками є коливні RLC-ланки; керовані двигуни постійного 

струму, в випадку коли 4Тя>Тм, де Тя – електромагнітна постійна часу кола 

якоря, Тм – електромеханічна постійна часу двигуна; пружні механічні передачі, 

наприклад для передачі обертового руху; гіроскопічні  елементи та ін. 

 

Часові функції і часові характеристики ланки.  

 

Перехідна функція коливної ланки представляється виразом 

),(1)sin(1)(
22

ttekth t 
















  



   

де 









21
 arctgarctg . 

Перехідна характеристика ланки зображена на рис 1. 

 
Для перехідної характеристики справедливі такі співвідношення: 

,
2

T


    Te

A

A 
2

1   і 
2

1ln
1

A

A

T
  

Імпульсна перехідна функція ω(t) (функція ваги) записується у вигляді 

tekt t 



  sin

)(
)(

22


  

Імпульсна перехідна характеристика показана на рис. 2 
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Рисунок 1 
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Частотні характеристики коливної ланки 

Амплітудно-фазова частотна функція (частотна передавальна функція) 

представлена в алгебраїчній формі має вигляд 

222222222222

22

22 4)1(

2

4)1(

)1(

2)1(
)(




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j
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TjT

k
jW












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де 
222222

22

4)1(

)1(
)(






TT

Tk
U




  – дійсна частотна функція, а  

 

222222 4)1(

2)(



TT

TkV


  – уявна частотна функція. 

Амплітудно-фазова частотна функція записана в показниковій формі 

виражається формулою 

221

2

222222 4)1(
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


 T

T
jarctg

e
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k
jW 




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    (3) 

Відповідна цій характеристиці амплітудно-фазова частотна 

характеристика (АФЧХ) показана на рис.3. 
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З (3) видно, що амплітудна частотна функція  

,

4)1(

)(
222222 


TT

k
A




 

фазова частотна функція 

2 2

2 2

2
, 1/ ,
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2
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T
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. 

Відповідні їм амплітудна частотна характеристика (АЧХ) і фазова 

частотна характеристика (ФЧХ) представлені  на рис. 4.  

 

 
Логарифмічна амплітудна частотна функція 
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де 1/сп T   – спряжена частота. 

 

На рис.5 показана асимптотична ЛАЧХ (пунктирна лінія) і точна ЛАЧХ 

(суцільна лінія). 
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2. Попередні завдання для обчислення 

1. Записати передавальну функцію коливної ланки, яка описується 

диференціальним рівнянням 

10212

2

0 xbya
dt

dy
a

dt

yd
a   

де 2

0 1 2 0, 2 , 1, .a T a T a b k     

Числові значення параметрів задані в таблиці 1. 

2. Записати вираз для перехідної  функції ланки h(t). 

3. Записати вираз для імпульсної перехідної функції ω(t) коливної ланки. 

4. Записати формули для розрахунку амплітудно-фазової частотної 

функції W(jω), амплітудної частотної функції А(ω), фазової частотної функції 

φ(ω), дійсної U(ω) і уявної V(ω) частотних функцій. 

5. Побудувати годографи АФЧХ і АЧХ досліджуваної ланки згідно 

варіанту. 

6. Побудувати асимптотичні ЛАХ коливної ланки. 

7. Визначити спряжену частоту ωсп і частоту зрізу ωзр по ЛАХ ланки. 

 

Таблиця 1 

Варіант Т·10
-4 

 
1
/с ξ k 

1 9,4 0,263 2,8 

2 9,3 0,271 2,9 

3 9,2 0,280 2,95 

4 9,1 0,290 3,0 

5 9,0 0,295 3,1 

6 8,9 0,3 3,2 

7 8,8 0,31 3,3 

8 8,7 0,32 3,4 

9 8,6 0,33 3,5 

10 9,5 0,26 2,83 

11 9,6 0,25 2,89 

12 9,7 0,24 2,93 

13 9,8 0,23 3,00 

14 9,9 0,22 3,1 

15 10 0,23 2,8 

16 10,1 0,25 2,7 

17 10,2 0,26 2,9 

18 9,3 0,27 3,0 

19 9,2 0,3 3,2 

20 9,1 0,33 3,3 

21 9,0 0,34 3,0 

22 9,6 0,28 3,1 

23 9,7 0,31 3,4 

24 9,8 0,30 2,9 

25 10 0,25 3,0 
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2.1 Приклад виконання попередніх завдань для обчислень 
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3. Робоче завдання. 

І. Дослідження часових характеристик ланки. 

1. Зняти осцилограму перехідної функції ланки. 

2. Зняти осцилограми імпульсної перехідної функції ланки. 

3. Порівняти результати експериментальних і теоретичних досліджень. 

 

ІІ. Дослідження частотних характеристик 

1. Зняти залежності А=ƒ(ω) і φ=ƒ(ω) досліджуваної ланки. 

2. Побудувати годографи АФЧХ досліджуваної ланки. 

3. Побудувати ЛАХ досліджуваної ланки. 

4. Визначити спряжену частоту ωс і частоту ωзр досліджуваних ланок. 

5. Порівняти результати теоретичних і експериментальних досліджень. 

 

4. Виконання робочого завдання 

 

1. Отримати перехідну характеристику аперіодичної ланки другого 

порядку засобами VisSim. 
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Рисунок 6 – Побудова перехідної характеристики 

 

2. Отримати імпульсну перехідну характеристику аперіодичної ланки 

другого порядку засобами VisSim. 

 

 
Рисунок 7 – Побудова імпульсної перехідної характеристики 

 

3. Побудувати годограф АФЧХ (годограф Найквіста). Для цього 

необхідно спочатку виділити блок передавальної функції досліджуваної 

системи і виконати команду: "Analyze -> Nyquist Response". 

 

4. Побудувати логарифмічні амплітудні та фазові частотні 

характеристики (виділити блок передавальної функції досліджуваної системи і 

виконати команду: "Analyze -> Frequency Response"). Відобразити на 

графіках координатну сітку. Подати отримані графіки в звіт. 

 

 
Рисунок 8 – Частотні характеристики 
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5. Порівняти результати, отримані в результаті моделювання з теоретично 

одержаними часовими та частотними характеристиками. 

 

6. Пояснити одержані результати (висновки). 

 

5. Порядок оформлення звіту 

 

Звіт оформляється відповідно до вимог ЄСКД на білому папері формату 

А4. На титульному аркуші вказуються назви міністерства, вузу, кафедри, 

роботи, прізвище студента, прізвище викладача. 

Звіт повинен містити наступні матеріали: 

1) тему і мету роботи; 

2) початкові дані; 

3) виконане попереднє завдання для обчислень; 

4) схему змодельованої САК; 

5) отримані в результаті моделювання часові та частотні 

характеристики; 

6) висновки. 

 

6. Контрольні питання і завдання 

1. Запишіть рівняння і передавальні функції коливальної ланки другого 

порядку. 

2. Перелічіть динамічні характеристики коливальної ланки і запишіть їх 

рівняння. 

3. Перелічіть частотні характеристики коливальної ланки і запишіть 

частотні функції. 

4. Наведіть приклади коливальних ланок. 
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Зображення найпростіших функцій часу по Лапласу 

Назва функції  tx      txLpX   

Дельта-функція  t  1 

Ступінчата функція  ta 10   pa0  

Степенева функція  tt n 1  1! npn  

Експонента  te t 1  )(1 p  

Синусоїда  tt 1sin    22  p  

Косинусоїда  tt 1cos    22 pp  

Періодична функція    Ttxtx      pTepX 1  

 

Зображення дробово-раціональних функцій по Лапласу 

 tx      txLpX   

 ate
a

1
1

 
 app 

1
 

 11
2

 ate
a

at  
 app 2

1
 

 btat ee
ab

 


1
 

  bpap 

1
 

 btat beae
ba

 


1
 

  bpap

p


 

 
  btat aebeba

baab

 


1
 

  bpapp 

1
 

 

Основні властивості перетворення Лапласа 

Назва Оригінал Зображення 

Лінійність 
 tax  

   txtx 21   

 paX  

   pXpX 21   

Правило диференціювання (при нульових 

початкових умовах) 
 
k

k

dt

txd
   kppX  

Правило інтегрування (при нульових 

початкових умовах) 
  k

k

t t

dx 


 
0 0

  
kp

pX
 

Зміна масштабу часу (теорема подібності) 








T

t
x   TpTX  

Зміщення аргументу оригіналу (теорема 

запізнення) 
 tx    pepX   

Теорема про початкове значення оригіналу  tx
t 0
lim


  ppX
p 
lim  

Теорема про кінцеве значення оригіналу  tx
t 
lim   ppX

p 0
lim

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